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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-
ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30
DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another
provided that the SOFTWARE is used on only one computer at a time. You shall not install
or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other
hardware configuration where the SOFTWARE is accessible to more than one CPU or to
more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes,
or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your
computer and retain the original for back-up purposes. Any other copying of the
SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright
notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support
for use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions
or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS
LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-
ROM storing the SOFTWARE is warranted only against defective material under normal use
for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be
replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection. The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR
ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You
may terminate this Agreement by destroying the SOFTWARE. This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE. In addition, Canon may enforce its
other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer
Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles. The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: Al rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use
of the SOFTWARE is subject to the United States, Canada and other applicable copyright
and trademark laws and nothing in this Agreement constitutes a waiver of the rights of
Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Introduction

This chapter includes information on the precautions to be read before using
EOS Utility, how to use this Instruction Manual, the system requirements and
the supported image types. It also explains the software features and
configuration.

About This Manual

Thank you for purchasing this Canon product.

Precautions for using this product safely and icons to help you with procedures, etc. are
described at the beginning of this Instruction Manual. Please be sure to read these first before
proceeding to the information in the other chapters.

® ltis prohibited to reproduce, in whole or part, the contents of this Instruction Manual
without permission.

® Canon may change without notice the software specifications and contents of this
Instruction Manual.

® The software screens and displays printed in this Instruction Manual may differ slightly
from the actual software.

® The content of this Instruction Manual has been reviewed thoroughly. However, if you
should notice any errors or omissions, please contact a Canon Service Center.

©® Please note that irrespective of the above-mentioned, Canon does not take responsibility
for the outcome of the operation of the software.

Trademark Acknowledgments

Canon and EOS are trademarks of Canon Inc.

IBM is a registered trademark of International Business Machines Corporation.

Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

Other names and products not mentioned above may be registered trademarks or
trademarks of their respective companies.

Click on the item to display its page.
About This ManUAl ..o s s snnns
System ReqUIremMeNnts ...
Compatible Models and Supported Images...
How to Use This Instruction Manual...........cccooiiiieiiinniie e
Software Main Features and Configuration ...

System Requirements
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Compatible Models and Supported Images

This software supports the following cameras and images.

Supported Cameras Supported Images

EOS-1D Mark IIN | EOS 30D
EOS-1Ds Mark I | EOS 20D
EOS-1D Markll | EOS 10D RAW and JPEG images
EOS-1Ds EOS DIGITAL REBEL XT/350D DIGITAL | shot with the camera on
EOS-1D EOS DIGITAL REBEL/300D DIGITAL the lsft
EOS 5D EOS D60

- EOS D30

oS Windows XP (Professional/Home Edition), Windows 2000
Computer with one of the above OS preinstalled and a USB port as a Setting the Cameras
Computer standard feature or an OHCIl-compliant IEEE1394 port
* Upgraded machines not supported. Othe_rthan the EOS-1D
: . Series Cameras
CPU 750MHz Pentium Il or higher L
RAM Minimum 256MB
Interface USB 1.1 to 2.0 Hi-Speed or IEEE1394
Displa Screen resolution: 1024 x 768 pixels or more X
play Color quality: Medium (16 bit) or more Series Cameras

Remote Shooting

Troubleshooting
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How to Use This Instruction Manual

Click to move to the
beginning of each chapter.

Square brackets [ ] are used to indicate items such as menu names, button names and
window names that appear on the computer screen.

Canon EOS Utility Instruction Manual
[ Cover/Table of

Contents
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®EOS Utility 1.0
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Click to move to the previous page.

Click to move to the next page.

:Marks information that should be read before
use to prevent problems that would interfere
with the functioning of software and computer.

Click to return to previously displayed page.

® In this manual, Windows XP Professional/Home Edition is referred to as “Windows XP”

and Windows 2000 Professional is referred to as “Windows 2000”. [}

® For more information on the restrictions of EOS Utility, refer also to the source listed
below.
Readme: Click the [Start] button B> select [All Programs] ([Programs] in Windows 2000)
» [Canon Utilities] » [EOS Utility] » [EOS Utility Readme].

:Marks additional information
that you will find helpful.

Reference page numbers are indicated in blue
either in brackets ( ) or within text. Click on the
page number to move to the corresponding page.

The camera name is shown in the screens as “EOS XXX".

Descriptions of camera operations assume that the reader is familiar with the
information in the camera’s Instruction Manual.

In this manual, the screens used in the examples are from Windows XP.

Text inside < > in this document indicates the keys on the keyboard and camera button
names.

» in this document indicates the sequence of
operation as shown on the right.

Example: [View] menu P> [Display Size] > [Large]

Window {4  HelptH)
Ctril

Smallig)
jum (M) Ctr+2

Ctrl+F Me

Thumbnail Frames
Image Information @ Ctrkl

0-2
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Software Main Features and Configuration

Canon Digital Camera software having the following features and functions is stored

on the EOS DIGITAL Solution Disk. Operation is done as shown on this page together with
each software application, centered around EOS Utility.

e==) : Shows the shot image flow.

==) : Shows the camera control information from the software.

Cover/Table of
Contents

: Shows software windows and descriptions of operation explained in this manual.
: Shows the Digital Photo Professional and ZoomBrowser EX windows and description of each operation.

Introduction

EOS Utility (Software for the Camera) -

Downloading Images
from the Camera

2105 Uity - Canan £05 & | Communicates with the camera to
download to your computer images saved
on the memory card inside your camera,
and can transfer images to Digital Photo L
Professional or ZoomBrowser EX (p.1-6).
You can download multiple images in a 1
single operation, display images as a list
and download only selected images (p.1-6

Setting the Cameras
otherthanthe EOS-1D

Camera settings _ to p.1-7). _
(p.2-1, p_3-1)g ’ ’ You can perform various settings for your Series Cameras
Remote shooting : camera (p.2-1, p.3-1). .
(p-4-1) J You can shoot photos by controlling the

camera from your computer and download
images to your computer (p.4-1).

Series Cameras

Transfer downloaded images (p.1-6) L
Transfer remotely shot images (p.4-1)

Remote Shooting

Digital Photo Professional (RAW Image Viewing and Editing Software) ZoomBrowser EX (Image Viewing and Editing Software)

=) @ Software recommended if you
mainly shoot RAW images.
Coupled with high-speed display
and processing of RAW images,
you can edit RAW images with a
variety of adjustment functions.

(You can also display and edit
JPEG images.)
For detailed instructions on Digital

Photo Professional, refer to the
“Digital Photo Professional
Instruction Manual”.

® Software recommended if you
mainly shoot JPEG images and
can perform a standard workflow
(procedure) of downloading,
viewing, editing, and printing
images.
For detailed instructions on
ZoomBrowser EX, refer to the
“ZoomBrowser EX Instruction
Manual”.

Troubleshooting
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1 Downloading Images from the Camera

This chapter explains preparations necessary to download images from your
camera to your computer, and downloading methods. It also explains how to
download images using a third-party card reader.

Click on the item to display its page.

Prepare to Download IMages ..........cccovimmiininnsis e 1-2
Setting a Camera with [Communication] Settings.........c..cccoccevvirienicniennee. 1-2
Connect the Camera and the Computer and then Start EOS Utility............. 1-3
Connecting a Camera other than an EOS-1D Series Camera to Your Computer.. 1-3
Connecting an EOS-1D Series Camera to Your Computer............cccceeeeeennee. 1-4
Precautions When Connecting the Camera and Computer.............cc.cccueee... 1-5
Downloading Images from Your Camera .........cccccceeririieeerrssssseesssssssseesesssnnns 1-6
Downloading All the Images in a Single Operation............cccccceiiiiiiieeiieenn. 1-6
Downloading Images to Your Computer by Operating the Camera................ 1-6
Downloading Selected IMages ..........ccceeeiiiiiiiiieiieeeee e 1-7
Downloading JPEG Images Using the PTP Function ...........ccccovivriiininnennn 1-8
Downloading for Cameras other than the EOS-1D Series Cameras.............. 1-8
Downloading with EOS-1D Series Cameras. .........cccceeueeerieeeiieeeeniieeeeee e 1-8
Precautions for the PTP FUNCHON ..........ccoceviiiiiiiiccc e 1-9
Downloading Images Using Your Card Reader............ccccoevmiicenninsennnnsnnnnnnes 1-9
Transferring the Images in a Specified Folder ..........cccccciivriniiiiiicniniennns 1-10
Specifying Preferences........ccccocvciiieiiniicncnne e 1-10
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Prepare to Download Images

Setting a Camera with [Communication] Settings

For a camera with [Communication] included as a menu function, you can communicate with

EOS Utility to download images to your computer by selecting a [Communication] setting.

® The setting on this page is necessary for the EOS 5D, EOS 30D, EOS 20D, EOS 10D,
EOS DIGITAL REBEL XT/350D DIGITAL and EOS DIGITAL REBEL/300D DIGITAL.

©® For cameras other than the above, it is not necessary to perform settings for the
camera. Continue with the procedure in “Connect the Camera and the Computer and
then Start EOS Utility” (p.1-3).

Check that the camera is not connected to the computer and then
set the camera’s power switch to <ON>.

Set the camera’s [Communication].

® With the EOS 30D, set [fT Communication]
in menu to [Print/PC].

® Set the [Communication] for other et
cameras in the same procedure as the |Date/Time 'l

EOS 30D, using the following for a \File numbering
reference. 'Language

Operation window in the EOS 30D

|Custom Functio

[Communication] settings for different cameras

Camera model Menu Setting
® EOS 5D [T Communication] [PC connect.]
® EOS 30D [T Communication] [Print/PC]
® EOS 20D [¥T Communication] [Normal]
® EOS 10D [Communication] [Normal]

® EOS DIGITAL REBEL XT/350D DIGITAL [¥T2 Communication] [PC connection]

©® EOS DIGITAL REBEL/300D DIGITAL [¥T2 Communication] [Normal]

Press the <MENU> button to switch the LCD monitor display off
and then set the camera’s power switch to <OFF>.

@ ® When setting the [Communication], always ensure that the camera is not connected
to the computer beforehand. Setting the [Communication] while the camera is
connected to the computer will cause camera and software malfunctions.

When using the EOS 5D or EOS DIGITAL REBEL XT/350D DIGITAL, the remote
shooting function and camera setting function in EOS Utility cannot be used if the
camera’s [Communication] is set to [Print/PTP].

When using the EOS 30D, the camera and EOS Utility cannot communicate if the
camera’s [Communication] is set to [LAN (WFT-E1)].

When using the EOS 20D, EOS 10D or EOS DIGITAL REBEL/300D DIGITAL, the
camera and EOS Utility cannot communicate if the camera’s [Communication] is set
to [PTP].

With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details
on changing, refer to the Canon’s web site.

About the PTP Setting

When using Windows XP, you can also download JPEG images that use the PTP (Picture
Transfer Protocol) function (p.1-8).

' Cover/Table of |
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Connect the Camera and the Computer and then Start EOS Utility

. ) Set the camera’s power switch to <ON>. Cover/Table of
Connecting a Camera other than an EOS-1D Series Camera to Your Computer ' R e — - Contents

Connection procedure for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL BT e
REBEL XT/350D DIGITAL, EOS DIGITAL REBEL/300D DIGITAL, EOS D60 and EOS D30 ‘ OFF r 2
Before downloading images to your computer or specifying the camera settings, you must 7 B / L e g = PeEral .
connect the camera to your computer with the interface cable supplied with the camera. IntrOd UCt|0n
You can connect the camera while your computer is running. B L

For instructions on connecting EOS-1D series cameras and your computer, refer to the next _;9 Starts to downlaad images

page.

i@ Lets you select and download images

Downlo glmages

o

2t up cameradShoot remately from the mera

Camera settings/Remote shooting

Plug the dedicated cable into the computer.

L3

Plug the cable into the USB port.
Refer to the computer User’s Manual for R T —
information on the terminal areas. g | Monior Folde [ . )
= Setting the Cameras
Series Cameras
@ [EOS Utility] starts up and main window is displayed, the camera is ready to 1
”(‘ communicate with your computer. Z =
Proceed to “Downloading Images from Your Camera” (p.1-6) continuously. .
Plug the dedicated cable into your camera. @ When the camera selection window appears, select the connected camera and then Set’fmg the EOS-1D
Face the <.€, > mark on the plug to the [EOS Ut|||ty] will start up. SerleS Cameras
front of the camera and connect the plug ® The above window shows information displayable when EOS 30D is connected. The L
to the camera’s < DIGITAL > terminal. % DIGITAY displayed information varies depending on the camera model connected.
. @ © |If the dialog box on the right appears, select [Canon T G5
] EOS Utility Downloads images from EOS camera] and | peescoreeees Remote Shooting
then click the [OK] button to start [EOS Utility]. y
\\ H Selec the program bo leunch for s acton
3\ If [EOS Utility] does not start, double-click the [EOS Ly Coron Cambimins L
L Utility] icon on the desktop or click the [Start] button » n
select [All Programs] ([Programs] in Windows 2000) » 1 )
[Canon Utilities] » [EOS Utility] » [EOS Utility]. T .
roubleshooting
[T g s s s s thes sxchon L
Index
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. . ) Set the camera’s power switch to <ON>. ' Cover/Table Of‘
Connecting an EOS-1D Series Camera to Your Computer - Contents

°°J NN A N\ 7 EOS Utility - FOS XXX B
Connection procedure for the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D Mark Il, EOS- “gk Dowrioads vsing compuier
1Ds and EOS-1D &7 or o .
WB AN

5@ Starts to download images
Before downloading images to your computer or specifying the camera settings, you must @ el ; 7 Q -
connect the camera to your computer with the dedicated IEEE1394 interface cable supplied ﬁ\ 5@ b AT Introduction
with the camera. You can connect the camera while your computer is running. L
® For instructions on connecting cameras other than the EOS-1D series cameras and your = _
COmputer, refer tO the preViOUS page- @ Camera settings/Remote shooting
Manior faider and impartimages Downlo g Im ages
Plug the dedicated cable into the computer. g | MomiorFode from the €amera
® Plug the cable into the IEEE1394 port. i
©® Refer to the computer User’s Manual for
information on the terminal areas. f . )
[EOS Utility] starts up and main window is displayed, the camera is ready to Setting the Cameras
communicate with your computer. Proceed to “Downloading Images from Your otherthanthe EOS-1D
Camera” (p.1-6) continuously. Series Cameras
When the camera selection window appears, select the connected camera and then L
[EOS Utility] will start up.
The above window shows information displayable when EOS-1D Mark Il N is f ]
Plug the dedicated cable into your camera. connected. The displayed information varies depending on the camera model Setting the EOS-1D
connected. 7
® For cameras supplied with the cable Series Cameras
protector, attach the cable protector to the ® If the dialog box on the right appears, select [Canon "
camera, and then follow the procedure EOS Utility Downloads images from EOS camera] and | g coreeens 2 "
below to connect the dedicated cable. then click the [OK] button to start [EOS Utility]. T —
® Make sure the < <= > mark on the plug is © |If [EOS Utility] does not start, double-click the [EOS [ —— .
facing the top of the camera and then Utility] icon on the desktop or click the [Start] button P> - m— Remote Shootmg
connect the plug to the camera’s select [All Programs] ([Programs] in Windows 2000) » —————
< DIGITAL > terminal. [Canon Utilities] > [EOS Utility] » [EOS Utility]. B e oo e o gseees 3
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Precautions When Connecting the Camera and Computer

®

You cannot communicate with the camera when you are displaying images through

the camera’s LCD monitor. Always connect the camera and your computer after

turning off the display in the LCD monitor.

While the camera and your computer are communicating, the camera’s LCD panel

may blink.

Use only the dedicated cable.

With EOS-1D series cameras, if you connect the plug of the dedicated cable into the

computer’s IEEE1394 port in the reverse direction, the camera or the computer may

break down. Confirm that the shape of the plug and the shape of the IEEE1394 port

match before connecting.

With EOS-1D series cameras, you cannot communicate with EOS Utility even if you

connect the USB interface cable supplied with the camera.

Push the plug firmly all the way into the socket. Loose connections can cause faults

or malfunctions.

Do not connect the camera to your computer via a hub. If you do so, the camera may

not operate correctly.

If you connect multiple USB or IEEE1394 devices (excluding mouse and keyboard) to

your computer, the camera may not operate correctly. Disconnect from your

computer any USB devices and IEEE1394 connection devices other than the

camera.

Operation of the Auto power off function will automatically switch the camera off,

disabling to communicate with your computer. Set the Auto power off function to

[OFF] in advance. For more details, refer to the camera’s Instruction Manual supplied

with the camera.

Do not connect more than one camera to the same computer. The connections may

not operate correctly.

The camera cannot communicate correctly with multiple softwares. Use one software

to communicate with the camera.

When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull

it out.

* If you are using the EOS D60 or EOS D30, pull the plug while pressing the <PUSH>
button on it.

If you do not perform any operation while the camera and computer are connected, a

confirmation message may appear on the computer screen asking whether you wish

to continue communicating with the camera for some computer systems. If you do not

perform any operation even after this message appears, the communication with the

camera is terminated. To re-establish the communication, press the shutter button

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

Do not put your computer to sleep while it is connected to the camera.

If your computer goes into the sleep mode, never disconnect the dedicated cable while

your computer is still in the sleep mode. Always wake your computer up while it is

connected to the camera. On some types of computer, disconnecting the dedicated

cable while your computer is in sleep mode could prevent the computer from waking

up correctly. Refer to the computer User’'s Manual for more information on sleep

mode.

5

When you connect the camera and your compulter, it is recommended that you use
the AC Adapter Kit (optional) for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS
DIGITAL REBEL XT/350D DIGITAL, EOS DIGITAL REBEL/300D DIGITAL, the DC
Coupler supplied with the camera for the EOS D60 and EOS D30, and the DC
Coupler Kit supplied with the camera for EOS-1D series cameras.

When connecting the EOS-1D series camera and a computer with a 4-pin type
IEEE1394 port, use the EOS-1D series dedicated Canon interface cable (optional) 4-
pin/4-pin type for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark Il, and a
4-pin/6-pin type for the EOS-1Ds and EOS-1D.

When using the dedicated cable supplied with the EOS-1Ds or EOS-1D, either plug
(6-pin type) can be connected to the computer or your camera.

When connecting the dedicated cable to the EOS D60 or EOS D30, insert it with the
<P> mark on the plug matched with the <P»> mark on the < DIGITAL > terminal.
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Downloading Images from Your Camera

Downloading All the Images in a Single Operation

You can download to your computer all the images saved on a memory card in the camera, in a
single operation. You can follow this same procedure when downloading images using a third-
party card reader (p.1-9).

Click the [Starts to download images] button.

The [Save File] dialog box appears and
the images are downloaded to the
computer.

The downloaded images are sorted in

) EOS Utility - Canon EOS 330¢

Douwnioads using camera

Press the camera’s button

folders by shot date, and are saved in the
[My Pictures] folder on the computer. =

When all the images have been @ S ol
downloaded, the ZoomBrowser EX starts Ty
up and the downloaded images are =
displayed. For further instructions, refer to
the ZoomBrowser EX Instruction Manual.
To exit EOS Utility, click the [Quit] button.
When disconnecting the interface cable
from the camera and computer, be sure to
exit EOS Utility and then set the camera’s
power switch to <OFF> before
disconnecting the cable.

Lets you swioue anu aownload images

St up camera/Shoot remolely

@ Camera setlings/Remote shooting

Moritor folder and impart images

] Monitor Folder
M

The above window shows information
displayable when EOS 30D is connected.
The displayed information varies depending
on the camera model connected.

® In the preferences, only images downloaded for the first time are downloaded and saved
in the [My Pictures] folder (you cannot download images previously downloaded). You
can change the image download type or the save destination in the dialog box (p.1-10)
that appears when you click the [Preferences] button.

@ You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.1-10). However, if you have
downloaded images following “Downloading Images Using Your Card Reader” (p.1-9),
the software that can start up is limited to ZoomBrowser EX.

Downloading Images to Your Computer by Operating the Camera

With cameras that have the direct image transfer function, you can download to your computer
images saved in your camera’s memory card by operating the camera. For detailed instructions
on the direct image transfer function, refer to the camera’s Instruction Manual supplied with
your camera.

This function is compatible with the EOS 30D.

Connect the camera and the computer and then start EOS Utility
(p.1-3).

Perform direct image transfer on the camera.

The images from the camera are saved to the computer.

When all the images have been downloaded, ZoomBrowser EX starts up and the
downloaded images are displayed. For further instructions, refer to the ZoomBrowser
EX Instruction Manual.

@ You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.1-10).
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You can select the folder of the Covelﬂ_able Of
H image displayed in the window. You can select the size of the displayed image.
Down Ioad I ng SeIeCted I m ages You can select images You can show/hide the image frame. Contents
by condition. . ) . . . .
You can display the images saved on a memory card in the camera, select the images you D):)wnloads the You can show/hide the image information display area.
want and download them to your computer. You can follow this same procedure when images to Starts the ZoomBrowser EX. r N
downloading images using a third-party card reader (p.1-9). computer. Deletes the image. ,
IL_-III| Introduction
. . EIEE B
Click the [Lets you select and download images] button. £ Dowodimer % 1 o] Mot « M 3w 8 &———————1 The display switches to .
. . L Ierm e the camera settings
=» The image download window appears and —— window (p.2-2, p.3-2).
the images on the memory card are PP % — Displays the histogram
displayed (brightness distribution). Downlo glmages
’ Bright.] is the brightness
n Press th % butt MG, 0001 PG MG D002 PG 1M 000 PG MG 0004 PG E‘J : from the mera
1ess the camera’s button |sp|ay_, and [RGB] is the
i B I~ r MG D002 JPG RGB display.
Downlaads using computer % MO
5@1 S g . jmoae —~ Displays basic shooting ( )
(_D ——_—— EEpuEgy | information. Setting the Cameras
s/ | Lets you select and download images E4 |
L : __ [soscime s L image information othgrthan the EOS-1D
T— E ig; E | ooz display area Series Cameras
[ - £05 M
EJ Camera settings/Remote shooting 3 Tl - nhgnﬁ .ﬁm:; H:'ﬁx o L
B oo (B sewncr F momacR "%~ " — Displays detailed
Moritor folder and impart images [l ek shooting information. ( )
1 _———————— | Eessm— ) I — - -
L.@ Monitor Folder Selects image 1 of 21 Settlng the EOS_1 D
Displayed on RAW+JPEG images. Displayed on images that are protected. Series Cameras
Displayed on RAW images.

The above window shows information
displayable when EOS 30D is connected.
The displayed information varies depending
on the camera model connected.

3 Click the [Download Images] button.

The [Download image] dialog box appears.

Specify the save destination and then click the [OK] button. Remote Shooting

¥ The [Save File] dialog box appears and the images are saved in the specified folder.

» When all the images have been downloaded, the ZoomBrowser EX starts up and the
downloaded images are displayed. For further instructions, refer to the ZoomBrowser
EX Instruction Manual.

Select the images to download.

® Click the target image.
® To select multiple images, hold down the <Ctrl> key and click the images.

® To select sequential images, click the first image and then hold down the <Shift> key

and click the last image. :
0 ® When switching to the main window, select the [Window] menu P [Main Window]. TrOUbleShOOtlng
To exit EOS Ultility, click the [File] menu P> [Exit]. L
When disconnecting the interface cable from the camera and computer, be sure to - ~
exit EOS Utility and then set the camera’s power switch to <OFF> before IndeX

disconnecting the cable.

ﬁl [[F1]is displayed on images previously downloaded to your computer. L
[ &3] is displayed on images shot with AEB.
With the EOS-1D series cameras, a [ [/ ] is displayed on images with sound recorded.
You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.1-10). However, if you have
downloaded images following “Downloading Images Using Your Card Reader”
(p.1-9), the software that can start up is limited to ZoomBrowser EX.
- QOO



Downloading JPEG Images Using the PTP Function

Downloading for Cameras other than the EOS-1D Series Cameras

Downloading method for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL
REBEL XT/350D DIGITAL and EOS DIGITAL REBEL/300D DIGITAL

When using Windows XP, you can use the PTP (Picture Transfer Protocol) function. When you
set the camera’s [Communication] and use the PTP function, you can download to your

computer JPEG images saved in your camera’s memory card without having to use EOS Ultility.

This function is compatible with the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS
DIGITAL REBEL XT/350D DIGITAL and EOS DIGITAL REBEL/300D DIGITAL.

Check that the camera and the computer are not connected and
then set the camera’s power switch to <ON>.

Set the camera’s [Communication].

Set the [Communication] for cameras in the same procedure as the “Setting a
Camera with [Communication] Settings” (p.1-2), using the following for a reference.

[Communication] settings for different cameras

Camera model Menu Setting
EOS 5D [¥T Communication] [Print/PTP]
EOS 30D [¥T Communication] [Print/PC]
EOS 20D [T Communication] [PTP]
EOS 10D [Communication] [PTP]
EOS DIGITAL REBEL XT/350D DIGITAL [¥T2 Communication] [Print/PTP]
EOS DIGITAL REBEL/300D DIGITAL [¥T2 Communication] [PTP]

Press the <MENU> button to switch the LCD monitor display off
and then set the camera’s power switch to <OFF>.

Connect the camera to the computer and set the camera’s power
switch to <ON> (p.1-3).
The window for selecting the software to use for downloading the images is
displayed.
Select [Microsoft Scanner and Camera Wizard] and click the [OK]
button.
The [Scanner and Camera Wizard] dialog box appears.

Download images as directed in the [Scanner and Camera
Wizard] dialog box.

@ With the PTP function, you cannot download RAW images.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details
on changing, refer to the Canon’s web site.

Downloading with EOS-1D Series Cameras

Downloading method for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark I
When using Windows XP, you can use the PTP (Picture Transfer Protocol) function by
connecting the supplied USB interface cable to the camera’s direct print terminal. By using the
PTP function, you can download to your computer JPEG images saved in your camera’s
memory card without having to use EOS Utility.
This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il

Plug the dedicated cable into the computer.

Plug the cable into the USB port.
Refer to the computer User’s Manual for
information on the terminal areas.

/ Plug the dedicated cable into your camera.
® Face the plug’s <*<> > mark towards the

bottom of the camera and then connect
the plug to the camera’s direct print
terminal.

) Set the camera’s power switch to <ON>.
=» The window for selecting the software to use for downloading the images is
displayed.
Select [Microsoft Scanner and Camera Wizard] and click the [OK]
button.
The [Scanner and Camera Wizard] dialog box appears.

Download images as directed in the [Scanner and Camera
Wizard] dialog box.

@ If you want to use the PTP function, connect with the USB interface cable supplied
with the camera.
With the PTP function, you cannot download RAW images.
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Select [View/Download Images using Canon CameraWindow] and Cover/Table of

Precautions for the PTP Function then click the [OK] button. Contents
CameraWindow MC (Image downloading Removable Disk (G:) X L
® Due to Windows XP specifications, you may experience the following restrictions with software for card readers) starts up. — . N
the PTP function. We recommend downloading shot images using EOS Utility (p.1-6). JtpbatlanitiNatdenctib et Tutati .
* RAW images cannot be downloaded. 5] Petues IntrOd UCt|0n

‘wihat do you want ‘indows to do

(Even if RAW images are displayed, they cannot be downloaded.)

* When a memory card in the camera contains both RAW images and JPEG images,
you may not be able to download the JPEG images.

» Shooting information for downloaded images may be altered or deleted.

» Images cannot be downloaded if there is a large quantity of images in the camera
(approximately 1,000 images).

= View a slideshow of the images
L using Windows Picture and Fax Viewer

U\ Print the pichures
[ S TR P ]

Downlo glmages

from the €amera

« It may take several minutes after connecting the camera and your computer until the BEI g ZeomBrowss: EX
PTP function is operational. ' Oipen folder to view files ~
« Vertically shot images become horizontal when downloaded, or an image does not [ ays do the selected o s )
rotate even if you use the Rotate command. ok ]) cacel ] Setting the Cameras
In addition to the above restrictions, you may not be able to download images correctly otherthanthe EOS-1D
CERRIPeib ERE SR e e e b eonvionment. Click the [Starts to download images] button or [Lets you select Series Cameras
and download images] button. 1

Downloading Images Using Your Card Reader g B [ e eting the EOS-1D

“Downloading All the Images in a Single Series Cameras

You can also download images to the computer using a third-party card reader. Operation” (p.1-6) and “Downloading _
= Selected Images” (p.1-7). lﬂl Starts to download images L
Load the card into the card reader. b =
The dialog box in step 2 appears. :;‘:}1 Lets you selact and download images
If the dialog box in step 2 does not appear, — Remote Shooting
click the [Start] button P> select [All
Programs] ([Programs] in Windows 2000) .
p [Canon Utilities] » [CameraWindow] , =
[CameraWindowMC] P [CameraWindow]. = ] :
Troubleshooting
@ Depending on the card reader you are using, you may not be able to download .
images. ' .
When downloading images using your card reader, the software that can start up is
limited to ZoomBrowser EX. |ndeX
@ For information on connecting the card reader to your computer, refer to the card '

reader User’s Manual.

When downloading images to your computer using a third-party card reader without
using Canon software such as EOS Utility or CameraWindow, refer to “Folder
Structure and File Names” (p.5-4) and copy to your computer the folder with the shot

l boe



Transferring the Images in a Specified Folder

By inserting images in a transfer origin folder, the images can be transferred to the transfer
destination folder and displayed in Digital Photo Professional or ZoomBrowser EX.

In addition, when using the EOS dedicated Wireless Transmitter WFT-E1/E1A (optional), by
specifying the folder where the shot images will be saved, you can check the shot images in
Digital Photo Professional or ZoomBrowser EX in real time.

Click the [Monitor Folder] button.
The [Monitor Folder] dialog box appears.

#7 E0S Utility - Canon EOS XX %]

Douinloads Lsing camera

L

Downloads using computer

Press the camera’s button

Stants to download images

/
I

Lets you select and download images

1§
I

2

St up camera/Shaat remalely

Camera settings/Remote shooting
|| Monitor Folder
@

The above window shows information
displayable when EOS 30D is connected.
The displayed information varies depending
on the camera model connected.

&

Set the transfer origin folder and the transfer destination folder.

Monitoring of the folder specified
as the transfer origin is cancelled.

- [ Retuntaman window_=—— Close the [Monitor Folder]
gllp%ryitf?éggsftﬁge folder —— dialog box to return to the

" ' main window.
transfer origin begins.

When using the WFT-E1 wireless File transmitter for EOS cameras, you
can instantly check photos you have shot in the linked software by
specifying the destination Folder Far those photos s the Monitored

Monitored Foldsr

———

[CImaritor all subfolders

change...

Destination Folder

(21 C:\Documents and Settings'My Pictures
{0 M0

i~ Click the [Browse] button
and in the dialog box that
appears, select the
transfer origin folder.

— Click the [Change] button
and in the dialog box that
appears, select the

transfer destination folder.

Click the [] button.

Image transfer preparation is complete.

Insert images in the transfer origin folder.

Images are transferred to the transfer destination folder, and ZoomBrowser EX starts

up.

® You cannot make the transfer origin folder and the transfer destination folder the same

folder.

Iil You can change the software that starts up when images are transferred, from

ZoomBrowser EX to Digital Photo Professional, in the [Preferences] as described next.

Specifying Preferences

You can perform various EOS Utility settings.

Click the [Preferences] button in the main window (p.1-6).

- » The [Preferences] dialog box appears.

Specify desired settings and click the [OK] button.
L The settings are applied to the EOS Utility.
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2 Setting the Cameras other than the EOS-1D Series Cameras

This chapter explains the functions that can be set in the EOS 5D, EOS 30D,
EOS 20D, EOS 10D, EOS DIGITAL REBEL XT/350D DIGITAL, EOS
DIGITAL REBEL/300D DIGITAL, EOS D60 and EOS D30.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-3).

© Click on the item to display its page.

Basic SettingsS......cccirimiiiiniii i —————————— 2-2
£ 4 Lo S T=Y 41 Vo = SR 2-3
PICtUIE StYIE .. 2-3
White Balance Adjustment...........oooiiiiiiii e 2-5
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Basic Settings

You can perform settings on the camera, such as setting the camera owner’s name and setting
the date and time.

Click the [Camera settings/Remote shooting] button.

=» The camera settings window appears. 7 £0S Utility - Canon EOS 300X X

Dounioads using camera

Press the camera’s button

R

Douinioads Lising computer
a Starts to download images

Lets you select and download images

Camera setlings/Remote shooting

m) ik

Moritor folder and import images

Monitor Folder

=
&

The above window shows information
displayable when EOS 30D is connected.
The displayed information varies depending
on the camera model connected.

Click [| #1 1.

=» The basic settings window appears.
® Click again to close the basic settings
window.

@) Ganon EOS XXX

File  Tool Window

P
150
AWB oo

(E)
2. .71, @01 %2 |

You can shoot photos remotely. For remote
shooting, refer to Chapter 4.

O65
O oSHOT
|“ e'?ggl@

® @

2 Select the item to be set and specify the settings.

The settings are applied to the camera.

You can show/hide the shot
settings window (p.2-3).

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window.

You can enter up to 31

characters and register the
You can set the camera’s camera owner’s name.
date and time.

You can initialize the

The camera’s firmware
version is displayed, and
you can perform updates.

Wer. 1.0.0

Displays the various —ﬂ ¥ — Closes the window.

camera information.
Returns to the previous window.

When switching to the main window, select the [Window] menu P> [Main Window].
@ If you select the [File] menu P> [Exit], EOS Utility exits, including the camera settings
window.
® The above window shows information displayable when the EOS 30D is connected.
The displayed information varies depending on the camera model connected.

® Initializing @ memory card deletes all the data and the data cannot be recovered. Check
carefully before initializing.
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Shot Settings

You can apply various shot settings to the camera.

Click the [Camera settings/Remote shooting] button.

-» The camera settings wiindow appears.

Click [(@a 1.

=» The shot settings window appears.
©® Click again to close the shot settings window.

Select the item to be set and specify the settings (p.2-3 to p.2-5).

=» The settings are applied to the camera.

You can show/hide the shot
settings window.

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window (p.2-2).

@ )

Picture Style

You can select a Picture Style and set it to the camera, or register a Picture Style file,
downloaded from Canon’s web site and saved on your computer, as a user setting in the
camera.

This function is compatible with the EOS 5D and EOS 30D.

Selecting a Picture Style

Click [Picture Style].

The [Picture Style] window appears.

~

Cover/Table of
Contents

Introduction

Downloading Images
from the Camera

Click the Picture Style to be set in the camera.

Setting ameras
other thanghte EOS-1D

Series ras

Standard The settings are applied to the camera,
0o and the display returns to the shot settings
window. Setting the EOS-1D
Series Cameras
Displays the various o ¥ — Closes the window.
camera information. Remote Shooting
Returns to the previous window.
® When switching to the main window, select the [Window] menu P> [Main Window]. L
® If you select the [File] menu P> [Exit], EOS Ultility exits, including the camera settings s
window. .
® The above window shows information displayable when the EOS 30D is connected. TI’OU b|eSh00t|n9
The displayed information varies depending on the camera model connected. L
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Detailed Settings ® You can register up to 3 user settings in your camera. Cover/Table of
When you select [Monochrome] in the [Picture Style] list box, the [Filter effect] and Contents

[Toning effect] list boxes appear. L
Refer to “Registering the Picture Style” in the camera’s Instruction Manual for

Click [Picture Style].

=» The [Picture Style] window appears. '/EK" m ) information about using the Picture Style registered in the camera.
— Click the [Apply] button. Introduction
The [Confirm settings] dialog box appears. L

Confirm the settings and click the [OK] button.

Click [Settings]. The settings are registered in the camera. Downloading Images
*» The [Picture Style setting] dialog b from the Camera
e [Picture Style setting] dialog box - - .
appears. (= Lo K1 Click the [Close] button. L
The [Picture Style setting] dialog box closes.
- . Setting ameras
Select the specified user setting. other thandlle EOS-1D

Following the “Selecting a Picture Style” procedure (p.2-3), select the specified Series ras
Picture Style.

The settings are applied to the camera, and the display returns to the shot settings
window.

Setting the EOS-1D

Specify desired settings. ﬁl A Picture Style file is a file that expands the Picture Style function. For detailed Series Cameras
information on Picture Style file, refer to the Canon’s web site.

Picture Style setting

) Remote Shooting

= If you have selected [User Defined1] to [User
= Defined3] in the [Picture Style] list box, you can
J click the [Open] button and load a Picture Style
) file saved on your computer. You can also
o123 4 5 6 7 select from the list box the Picture Style that will s
S become the base style.

Sharpness :

Troubleshooting

-

¥2 43 +4

Contrast

—— Drag the slider for each item left or right to set.

-4

+2 43 +4

S aturation :

Index

-5

+2 43 44

»
Reli=b ey | Standard _~—— Select the Picture Style to be set. ]

Lol oL o

Color bore: :

Tlose |
!
Cancels all the settings and closes the dialog box.

Deletes the selected Picture Style from the camera.
Applies the settings to the camera.

-~ Q0O



White Balance Adjustment

You can compensate the white balance and apply it to the camera.
® This function is compatible with the EOS 5D, EOS 30D, EOS 20D and EOS DIGITAL
REBEL XT/350D DIGITAL.

Click [WB SHIFT].

=» The white balance adjustment window (—ﬁ_l
appears. E

Click the compensation position.

=» The settings are applied to the camera.

Compensates green.

Displays the
compensation value.

Compensates blue. Compensates amber.

e (=] [x]

Click [[#5)]].

=» The display returns to the shot settings window.
® To revert the corrected values to the original values, follow the procedure in step 2.
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3 Setting the EOS-1D Series Cameras

This chapter explains the functions that can be set in the EOS-1D Mark II N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds and EOS-1D.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-4).

© Click on the item to display its page.

Basic SettingsS......cccirimiiiiniii i —————————— 3-2
£ 4 Lo S T=Y 41 Vo = SR 3-3
PICtUIE StYIE .. 3-3
Specifying the Personal White Balance............cccoccviiiieeiniie e 3-5
Specifying the JPEG QUAIITY .......oooiiiiiiiiieiiee e 3-6
White Balance Adjustment........ ..o 3-6
Specifying the Parameters...........ooouiieiiiieiiee e 3-7
Specifying the Color MatriX .........cccuiiieiiiiiiiie e 3-8
Personal Function Settings..........ccccoiimiiiiniiniinis s 3-8
Description of Personal FUNCLIONS ............ooooiiiiiiiiii e 3-9
Checking Personal Function Settings ...........c.ccceviiiiiiie e 3-14
Saving and Loading Personal Function Settings ...........cccccoocvviieeiiciiiinee e, 3-15

~
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Basic Settings

You can perform settings on the camera, such as setting the camera owner’s name and setting
the date and time.

Click the [Camera settings/Remote shooting] button.

=» The camera settings window appears. ) 05 Utility - FOS 300% X

Downloads using computer
4’@ Starts to download images

Lets you select and download images

) s

Camera settings/Remaote shooting

Moritor folder and impart images

!
[ | Monitor Folder

The above window shows information
displayable when EOS-1D Mark Il N is
connected. The displayed information varies
depending on the camera model connected.

Click [| #1 1.

=» The basic settings window appears.
® Click again to close the basic settings
window.

&) Ganon EOS XXX
File  Toal Window

EoX

-
P

150
108

|
] =
-2I I-'u. I!‘ .‘1! -"2

OXGCIO .
O ONESHOT >
# :geel‘@

You can shoot photos remotely. For remote —
shooting, refer to Chapter 4.

2 Select the item to be set and specify the settings.

The settings are applied to the camera.

You can show/hide the shot
settings window (p.3-3).

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window.

You can enter up to 31

characters and register the
You can set the camera’s camera owner’'s name.
date and time.
You can set the Personal

Function (p.3-8).

Displays the various —ﬂ
camera information.

¥ — Closes the window.

Returns to the previous window.

When switching to the main window, select the [Window] menu P> [Main Window].
@ If you select the [File] menu P> [Exit], EOS Utility exits, including the camera settings
window.
® The above window shows information displayable when the EOS-1D Mark Il N is
connected. The displayed information varies depending on the camera model
connected.

® With the EOS-1Ds and EOS-1D, the [Format] item is displayed and you can initialize the
memory card. Initializing @ memory card deletes all the data and the data cannot be
recovered. Check carefully before initializing.
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Shot Settings

You can apply various shot settings to the camera.

Click the [Camera settings/Remote shooting] button.

=» The camera settings window appears.

Click [(@a 1.

=» The shot settings window appears.
©® Click again to close the shot settings window.

Select the item to be set and specify the settings (p.3-3 t0 p.3-8).

=» The settings are applied to the camera.

You can show/hide the shot
settings window.

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window (p.3-2).

@ "

Standard

JPEG Quality

SHIFT

Displays the various
camera information.

o *— Closes the window.

Returns to the previous window.

® When switching to the main window, select the [Window] menu P> [Main Window].
® If you select the [File] menu P> [Exit], EOS Ultility exits, including the camera settings

window.

® The above window shows information displayable when the EOS-1D Mark Il N is

connected. The displayed information varies depending on the camera model
connected.

Picture Style

You can select a Picture Style and set it to the camera, or register a Picture Style file,
downloaded from Canon’s web site and saved on your computer, as a user setting in the
camera.

This function is compatible with the EOS-1D Mark Il N.

Selecting a Picture Style

Click [Picture Style].
The [Picture Style] window appears. (E )

JPEG GQuality

SHIFT

Click the Picture Style to be set in the camera.

@ = The settings are applied to the camera, (—a_l
and the display returns to the shot settings =
window.

3-3
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Detailed Settings

Click [Picture Style].

=» The [Picture Style] window appears.

Click [Settings].

=» The [Picture Style setting] dialog box
appears.

Specify desired settings.

Picture Style setting |

Picture Style : | Standard LI—
N\
(e |
o1 2 4 5 B 7
Sharpress : J\I
43 2 1 0 41 42 43 +4
Contrast : I J\l I I a
4 3 2 1 0 41 +2 43 +4
S aturation : I I j I
43 2 10 41 +2 43 +4
Caolor tone : I I j I

— Select the Picture Style to be set.

— If you have selected [User Defined1] to [User
Defined3] in the [Picture Style] list box, you can
click the [Open] button and load a Picture Style
file saved on your computer. You can also
select from the list box the Picture Style that will
become the base style.

— Drag the slider for each item left or right to set.

— Cancels all the settings and closes the dialog box.

Applies the settings to the camera.

1
Deletes the selected Picture Style from the camera.

® You can register up to 3 user settings in your camera.
When you select [Monochrome] in the [Picture Style] list box, the [Filter effect] and
[Toning effect] list boxes appear.
Refer to “Registering the Picture Style” in the camera’s Instruction Manual for
information about using the Picture Style registered in the camera.

Click the [Apply] button.

The [Confirm settings] dialog box appears.

Confirm the settings and click the [OK] button.

The settings are registered in the camera.

Click the [Close] button.
The [Picture Style setting] dialog box closes.

Select the specified user setting.

Following the “Selecting a Picture Style” procedure (p.3-3), select the specified
Picture Style.

The settings are applied to the camera, and the display returns to the shot settings
window.

ﬁl A Picture Style file is a file that expands the Picture Style function. For detailed
information on Picture Style file, refer to the Canon’s web site.
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_— . ) Click the [Open] button. Cover/Table of
Specifying the Personal White Balance The [Open] dialog box appears. Contents

Up to 3 white balance files saved with RAW Image Task can be registered in the camera as

personal white balance. Personal white balance settings E| p .
©® These functions are compatible with all EOS-1D series cameras. e e b e .
® For how to save a white balance file with RAW Image Task, refer to “Processing RAW . ) ) IntrOd UCtlon
o . — Displays the setting status for the
Images” in the ZoomBrowser EX Instruction Manual. . s personal white balance registered L
® When you register a personal white balance file to the camera, < P - { >to< Pl -3 >is on the camera along with their
Personal white balance setting name: titles. -~ ~

displayed on the rear LCD display panel of the camera. N
® For more information on setting the personal white balance on the camera, refer to | \%)

Tie: Downloading Images
“Selecting the White Balance” in the camera’s Instruction Manual. r t 9 g
— from the Camera
Click [Personal white balance]. [tk 57— Closes the dialog box. <

=» The [Personal white balance settings] ) , . )

dialog box appears. \ ) Deletes the selected personal white balance from the camera. Setting the Cameras

Registers the selected personal white balance settings on the camera. otherthanthe EOS-1D

Enter a title for the personal white balance to be registered. Series Cameras

Open the folder containing the saved white balance file, select the

_* file, and then click the [Open] button. Setting t 0S-1D
2 Select the personal white balance to be registered. = The white balance file is loaded. Series Cafijeras
Enter a title in the [Title] input box.
Perzonal white balance zettings > y -
Personal white balance 1[PC-1]: Not set - - 1
Personal white balance 2[PC-2] - Mat set Click the [Apply to camera] button. Remote Shooting
Perzonal white balance 3[PC-3) : Mot zet
- The personal white balance file is registered on the camera.
| <_ = _] ? » To register another setting, repeat steps 2 to 6. You can register up to 3 settings 1
(PC-1, PC-2 and PC-3). < \
"% Click the [Close] button. Troubleshootlng
v The [Personal white balance settings] dialog box closes, and the display returns to L
the shot settings window.
Index
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- ___0__0_00000000000_]
Specifying the JPEG Quality White Balance Adjustment

Cover/Table of
Contents

You can specify the JPEG quality and register the settings on the camera. You can compensate the white balance and apply it to the camera.
® This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D © This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il Mark Il. -
Introduction
Click [JPEG Quality]. Click [WB SHIFT].
=» The [JPEG Quality] window appears. -» The white balance adjustment window . f
appears. Downloading Images
from the Camera
Setting the Cameras
. . . . . . otherthanthe EOS-1D
Click the setting position. Click the compensation position. Series Cameras
=» The settings are applied to the camera. - ~» The settings are applied to the camera.
(@) Lo )

® Higher values give a lower compression
ratio and higher image quality for any size.

(@ &l i) Setting th&EOS-1D

Series Cameras
Compensates green.

Displays the
compensation value.

Compensates blue. Compensates amber.

Remote Shooting

Compensates magenta.

Click [[25]].

=» The display returns to the shot settings window.

Click [[5]]. Troubleshooting

=» The display returns to the shot settings window.
© To revert the corrected values to the original values, follow the procedure in step 2.

Index
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Specifying the Parameters

You can upload sharpness and contrast settings as well as a tone curve file saved with RAW

Image Task and register up to 3 of these in the camera as processing parameters.

® This function is compatible with the EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds and
EOS-1D.

® For how to save a tone curve file with RAW Image Task, refer to “Processing RAW Images”
in the ZoomBrowser EX Instruction Manual.

® For more information on setting the processing parameters on the camera, refer to “Setting
the Processing Parameters” in the camera’s Instruction Manual.

1 Click [Parameters].

=» The [Parameters settings] dialog box
appears.

15tandard

2 Select a tab to be set.

Parameters settings

‘ Set1 |set2 |Set3 »)

\F

2 Specify desired settings.

Parameters settings &‘
Setl Setz Set3
Tone Curve;
Ol
() User Defined
TCD1
0 1 2 E:| 4 5
Sharpness : j
-2 =il 0 +1 +2
' i I
Contrask ; — 4Q g
Apply to Camera
— 1 -
Close =

[Standard]:
The standard tone curve is set.

[User Defined TCD1] to [User Defined
TCD3]:

You can apply the tone curve file saved in
RAW Image Task.

With the EOS-1Ds and EOS-1D, [User
Defined] is displayed and you can select
one tone curve file.

Click the [Add] button and in the dialog box
that appears, select the tone curve file
saved on your computer.

— Applies the settings to the camera.

— Closes the dialog box.

Drag the slider left or right to specify the sharpness and contrast.
With the EOS-1Ds and EOS-1D, [Sharpness] and [JPEG Quality] are displayed. Select
the item to be set from the list box.

% Click the [Apply to Camera] button.

=» The [Confirm settings] dialog box appears.

Click the [Close] button.

Confirm the settings and click the [OK] button.

=» The processing parameter is registered on the camera.

The [Parameters settings] dialog box closes, and the display returns to the shot

settings window.
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Personal Function Settings

You can set detailed settings for each function and apply them to the camera. You can also
save the specified settings on your computer and load the saved settings.
These functions are compatible with all EOS-1D series cameras.

-

Cover/Table of

Specifying the Color Matrix Contents

You can set the color matrix. You can also set in the camera up to 2 color matrix ([6CM set1]

and [7CM set2]) that have color space, color saturation and color tone set optionally.

® This function is compatible with the EOS-1Ds Mark Il and EOS-1D Mark II.

® For more information on setting the color matrix on the camera, refer to “Selecting the Color
Matrix” in the camera’s Instruction Manual.

Click [Color matrix].

=» The [Color matrix] window appears. —_—
(=)

€A )

(1) (]

Click the color matrix to be set in the camera.

Click the [| ¥T )] button.

The basic settings window appears.

Click [Personal functions].

The [Personal functions] dialog box
appears.

Select a tab to be set.

Bersonal funciions

|

=» The settings are applied to the camera, m,\_ 1) | AF funcions Drive functions Other functions 1
. N 1 Other functions 2 Other functions 3 Combination
and the display returns to the shot settings . m H* B e fm.uns‘]fl Expasure functions 2 J‘Expom functior X1
window.

® For the color space, color saturation and
color tone of [6CM set1] or [7CM set2],
click the [Settings] button and set in the
[Color matrix settings] dialog box that

[C1{P Fre01) Disables the shooting modes
able progre
I shutter-p
-psrture-pri

[ 1ual expr

(a7

Introduction

Downloading Images
from the Camera

Setting the Cameras
otherthanthe EOS-1D
Series Cameras

|
e
i

|

Setting t

0S-1D
Series Cafieras

Remote Shooting

appears. - _ : >
I l .EP.FH-DZ) Disables the matering modes -
i) [5)x] .
. Troubleshooting
® The optional settings [Color space], [Saturation] and [Color tone] in the [Color matrix L
settings] dialog box can only be set when [6CM set1] or [7CM set2] is selected in the
[Color matrix] list box. Loads the details of the Personal 1
Functions that have been specified on
the camera. I nd ex

[ losdsettngs | Recet —

[ Apply to camera | [ oK J [ concel =

— Cancels all the settings and closes the

dialog box.

I
Applies the settings
to the camera.

=» The selected window appears.

I
Applies the settings to the camera
and closes the dialog box.

©® In the [Combination] tab sheet, you can check the specified Personal Function
settings and the status of whether or not the settings are applied to the camera. You

can also save and load the Personal Functio

n settings (p.3-14, p.3-15).

— All data set in each window is cancelled.

3-8
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Checkmark the box [[] and specify desired settings (p.3-9 to p.3-14).

r( Fr-01} Disables the shooting modes

|| Cisable program AE

[ pisable shutter-priority AE
[ pisable aperture-priarity AE
[ cisable manual exposure

[ ]risable bulb exposure

If you enter a numerical value, values outside the valid range of settings are ignored.

Check the settings and save them on your computer if necessary
(p.3-14, p.3-15).

Click the [OK] button.

The settings are applied to the camera,
the [Personal functions] dialog box closes, ,'ES

(50
av 55 _Oesor

and the display returns to the basic

settings window. [@- @

When a Personal Function is applied to = AP T
] e ¢ 2. . 1..(2.. 1. 42, 3

the camera, <ff> appears on the LCD

panel.

Description of Personal Functions

The shown in this section provides brief descriptions of the Custom Function Settings
for the respective camera functions. For more details, refer to “Custom Function Settings” in

the camera’s Instruction Manual supplied with the camera.

[IFX 10 Disables the shooting modes

Checkmark the shooting modes you do not want to use.

Unwanted shooting modes can be skipped while you are selecting the shooting mode.

This makes selecting the desired shooting mode faster.
With the EOS-1Ds and EOS-1D, [Disable depth-of-field AE] is also displayed.

® At least one checkbox must be left unchecked.

[IiX 71 Disables the metering modes

Checkmark the metering modes you do not want to use.

Unwanted metering modes can be skipped while you are selecting the metering mode.

This makes selecting the desired metering mode faster.

@ At least one checkbox must be left unchecked.

2IHi5E] Specifies the metering mode for manual exposure
® Select the metering mode to be specified.
You can specify the metering mode to be used in the manual exposure mode.

When you set the manual exposure mode, the metering mode selected here will be set
automatically. In the manual exposure mode, this enables you to use a metering mode

different from the one used in the AE modes.
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[ATE7] Sets the maximum and minimum shutter speeds to be used Cover/Table of

Select the maximum and minimum shutter speeds from the list box. Registering the Modes and Settings with the Camera Contents
For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the
slowest, the shutter speed range will be 1/2000 to 1/60 sec.

This makes shutter speed selection faster and prevents a slow-speed sync. in aperture-

Set the shooting mode and shooting mode settings (for
example, aperture setting for aperture-priority AE mode). Then )
set the metering mode and exposure compensation amount.

priority AE mode with the flash. Introduction
Register the modes and settings.
@ If you set the maximum and/or minimum shutter speed to one that is not a full-stop L
increment (such as 1/750 sec.), the controllable and settable shutter speed range First press the < [24 > button, then press , =
might not be as exact as you set it (A slight deviation may occur.). This applies if you the < [+3 > button.

also set Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or
minimum shutter speed to one that is not a full-stop increment (such as 1/3200 sec.).
To ensure that a proper flash sync speed is set in the Program AE mode, a shutter
speed range of 1/200 sec. to 1/80 sec. cannot be set with the EOS-1D Mark Il N,
EOS-1Ds Mark I, EOS-1D Mark Il and EOS-1Ds, and the range of 1/400 sec. to 1/80
sec. cannot be set with the EOS-1D.

If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter
speed range.

Downloading Images
from the Camera

€ J

C 2!

Setting the Cameras
otherthanthe EOS-1D
Series Cameras

< O >appears in the LCD panel,
indicating that the modes and settings
have registered.

The registered modes and settings can
[Z@XH Sets the maximum and minimum apertures to be used be modified any number of times.
Select the maximum and minimum apertures from the list box.
For example, if you set 1.4 for the largest aperture (minimum f/number) and 8.0 for the

Setting t 0S-1D

smallest aperture (maximum f/number), the usable aperture range will be f/1.4 to 1/8.0. ® ® To register the modes and settings, first press the < [ > button before the < S Series Camieras
You can better control the apertures used by setting the range of usable apertures. button. If you press the < > putton first, the camera will only select the
® registered modes and settings instead.
Specify a minimum aperture value that is smaller than the maximum aperture setting. @ Bulb cannot be preset. ( )
If you select a minimum aperture value that is larger than the maximum apérture, a ® You cannot select the registered modes and settings during continuous shooting.
warning message appears and the setting reverts to the default value. Remote Shooting
If you set the maximum and/or minimum aperture to one that is not a full-stop =
increment (such as f/4.5), the controllable and settable aperture range might not be il © If P.Fn-03 has been set to specify the metering mode for manual exposure, and L
as exact as you set it (A slight deviation may occur.). This applies if you also set P.Fn-06 is used to register the manual exposure mode and a metering mode
Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum different from the one specified with P.Fn-03, you can select the metering mode ~
aperture to one that is not a full-stop increment (such as /6.3). specified with P.Fn-03 by pressing the < > button. .
If the largest aperture of the attached lens is smaller than the largest aperture you set 9 If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture within TI’OU bleShOOtmg
with P.Fn-05, the largest aperture will be set to the lens’ largest aperture. And if the the range specified with P.Fn-04 and/or P.Fn-05. L
largest aperture of the attached lens is smaller than the smallest aperture you set with If the shooting and metering modes you want to set are excluded by the
P.Fn-05, the aperture will be set and fixed to the lens’ largest aperture. restrictions in P.Fn-01 and P.Fn-02, those Personal Functions must be disabled. 2
If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05's aperture range. For information on clearing and resetting Personal Functions, refer to “Clearing
and Resetting Personal Functions” in the camera’s Instruction Manual supplied IndeX
with the camera.
| P.Fn-06 | Registers and switches the shooting mode and metering mode Even if the shooting and metering modes selected by P.Fn-06 are excluded by the L .

Only while you press the < [53] > button, you can switch to the preset shooting mode, restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

exposure setting (such as the aperture for aperture-priority AE), metering mode, and e

exposure compensation amount. If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when you
Select settings that are appropriate for each shooting mode. press the < > button.

The modes and settings are preset with the camera. When C.Fn-18 is set, P.Fn-06 is disabled.

Convenient when you want to instantly select the preset modes and settings to suit a
particular shooting situation such as backlit or front-lit conditions. 3-10




AT Repeats bracketing during continuous shooting [XTEI] Retains the shift amount for program shift Cover/Table of
While you hold down the shutter button, bracketing repeats continuously in the currently Normally, any program shift amount is canceled after you take the picture. This Personal Contents
selected drive mode. Function retains the program shift amount. L
This function is useful when you want to continuously repeat the bracketing sequence. This function is useful when you want to shift the standard program line so that priority is 3 .

given to the shutter speed or to the aperture.

AT Sets the number of shots to be bracketed By shifting the program, you can change the shutter speed or aperture and still retain the same |ntr0d uction

) exposure level. Under the same brightness, you can shift the program line toward the right to
Select the number of shots from the list box. set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the program "
The usual 3-shot bracketing is changed to 2-, 3-, 5-, or 7-shot bracketing. line toward the left to set a slower shutter speed and a smaller aperture (higher f/number). b =
In bracketing shots, if you select 5-shot bracketing with 1-stop increment, the bracketing for P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the level
the shots is =2, —1, 0, +1 and +2. of priority you want to give to the shutter speed or aperture setting. Downloading Images
This function is useful for adjusting the range of bracketing. from the Camera
Darker « Brightness (EV at ISO100) — Brighter
@ Even when the setting is outside the bracketing level display range, the exposure is 5 6 7 8 9 10 11 12 13 14 15 16 17 18 18 20 21 22 23 Aperture "
compensated as specified. N ‘ 32 2 -
This function can be used in combination with C.Fn-09-2/3 and P.Fn-09. ¢ 2 Setting the Cameras
8 M /) 16 otherthanthe EOS-1D
[IZXT] Changes the bracketing sequence for C.Fn-09-2/3 to increased ’ S // ’ Series Cameras
exposure, standard exposure, and decreased exposure 1 / . "
The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure - standard 0 Sy // ,/ 56
exposure - increased exposure) changes to increased exposure = standard exposure —> : \’/ Vg Setting t 0S-1D
’ , . .
def:reaseq exPosure. ' . ' ) p / < /7 Series Caleras
This function is useful when you want to start the bracketing sequence with a increased / 7~ 28
exposure. 3 / / 7 / ~ )
. . . . . g -4 // // 7/ AN s N
@ This function can be used in combination with P.Fn-08. N
-5 \\ .
30 15 8 4 2 1 2 4 8 15 30 60 125 250 500 1000 2000 4000 BO(JC:.0 RemOte ShOOtIng
— Shutter Speed
e Standard program line L
== == == Program line shifted toward a faster shutter speed.
= Program line shifted toward a slower shutter speed. s N
With EF50mm /1.4 USM Troubleshooting
@ The program shift amount remains in effect until you set it back to the standard program
manually or replace the battery or press the <CLEAR> button.
The shift amount is retained even after you change the lens. |ndex

[IFi¥E] Executes Al Servo AF continuous shooting giving priority to
the drive speed
This function is compatible with the EOS-1D only.
During continuous shooting, shutter release-priority takes effect instead of focus-priority.
Effective when it is more important to capture an image even though it might be slightly out

of focus. @ @ @
3-11



=] Disables focus detection (search driving) by the lens drive
Normally, when you press the shutter button halfway and focus cannot be achieved, the
lens is driven to search the correct focus. This lens driving operation can be turned off.
When focus has been achieved once and refocusing fails, the subsequent lens driving
operation can result in grossly out of focus. This subsequent lens driving operation is turned
off. P.Fn-14 is especially suited for super telephoto lenses.

@ If autofocusing is attempted while the lens is way out of focus, the lens may stop
operating. Focus manually until the subject outline becomes discernable, then
autofocus.

[Fi¥H Disables the AF-assist beam from being emitted
This disables the external Speedlite’s built-in AF-assist beam.
At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the
subject from being photographed by other photographers.

[ZFE Enables automatic shooting when focus is achieved at the
fixed point of focus while the shutter button is pressed fully

This takes the picture automatically when the subject comes to the preset focusing distance.
Focusing detection is performed using the selected AF point.
Set the lens focus mode switch to <MF> and focus manually at the desired point of focus.
Keep pressing the shutter button fully.
Using an accessory such as Remote Controller RS-80N3 which can lock the shutter button
relieves you from holding down the shutter button while you wait for the subject.

@ Because the camera remains on standby while the shutter button is fully pressed,
battery power is used up more quickly. For long periods of photography, use the DC
Coupler Kit supplied with the camera.

When this function is used in combination with a flash, the flash remains on standby
at full charge. Consequently, the flash batteries are used up more quickly. (The
Speedlite’s SE mode is disabled.)

When you use a flash with this function, set the drive mode to single shooting. If you
select continuous shooting, the flash will be unable to charge in time for successive
shots and will not fire at full charge.

If you set the drive mode to continuous shooting, set the number of shots in P.Fn-20.
If you do not use P.Fn-20, once the camera focuses on the subject, continuous
shooting will continue until the capacity of the memory card is reached.

P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow to
be used with autofocusing.

Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of
whether the image is in focus.

@ Using an accessory such as Remote Controller RS-80N3 which can lock the shutter
button is recommended.

Ai5Fd Disables automatic AF point selection
When you select beyond the peripheral AF point, the selection stops there. It makes
selecting a peripheral AF point faster.

If C.Fn-11-2 has been set, you can switch to automatic AF point selection by pressing
the < > button during autofocusing. For more details, refer to “Selecting the AF
Point” in the camera’s Instruction Manual supplied with the camera.

If automatic AF point selection has been preset at [AF frame registration] setting, the
preset setting remains valid. For more details, refer to “Registering and Switching the
AF Point” in the camera’s Instruction Manual supplied with the camera.

Enables automatic AF point selection when C.Fn-11-2 has
been set
Enables the standard horizonal AF point selection together with automatic AF point
selection with C.Fn-11-2.
Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been
set.

@ If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will
override P.Fn-18 to disable automatic AF point selection.

[ZTEE] Sets the continuous shooting speed
In the list box, select the speed of continuous shots during continuous shooting.

® By reducing the maximum continuous shooting speed, Al Servo AF continuous shooting can
be more stable.
With the EOS-1Ds Mark Il and EOS-1Ds, only [Continuous Shooting] is displayed.

® In Al Servo AF, it may not be possible to complete the selected speed of continuous
shots.

[0 Limits the number of shots during continuous shooting

This enables you to enter the maximum number of shots to be exposed during continuous
shooting while the shutter button is pressed fully.
Convenient when you do not want to shoot an unwanted scene that follows.

3-12
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[XT¥Z1 Enables quiet operation when the shutter button is OFF after
picture-taking
When single shooting is selected, this function selects quiet camera operation when you
release the shutter button from the fully pressed position to the half way position.
This is useful when the camera operation noise would be disturbing after you take the
picture.

@ If you select continuous shooting, the camera operates normally.

ili Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

[XZ¥E] Changes the timer’s time length
After you press and release a button, the respective function remains active for a specific
number of seconds. You can change this number of seconds as necessary.
The function’s activation time can be set from 0 to 3600 sec. (1 hour).
If the standard activation time is too short or too long, you can adjust it.

AE lock time after you press the shutter button halfway or the < ¥ >

6 sec. timer button.

16 sec. timer FE lock time after you press the <FEL > button.

Exposure setting retaining time after the picture is taken. Setting
this to a longer time can make it easier to shoot in the same
exposure with AE lock.

LCD panel illumination time after the picture is taken.

Post-shutter
release timer
(2 sec. timer)

® Note that if you set a longer activation time, the battery become exhausted more quickly
and the number of possible shots will be reduced.

@ To turn off the function’s activation time midway, press the < MODE > button, < AF >
button or < > button.

[ZE¥A llluminates the LCD panel during bulb exposures

After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the
LCD panel until the bulb exposure ends.
Convenient when you want to monitor the elapsed bulb exposure time.

@ Note that if you take bulb shots for long periods, the battery becomes exhausted more
quickly and the number of possible shots will be reduced.

[T¥H Sets the default settings when the <CLEAR> button is ON

You can use this function to select the default settings when you press the <CLEAR>
button.

Convenient when you want to instantly switch to frequently-used settings.

[F¥13 Shortened release time lag
This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il.
Normally, the shutter-release time lag is controlled for stability. This Personal Function
eliminates this control. As a result, the shutter-release time lag can be reduced by as much

as about 20 percent when the aperture needs to be stopped down by no more than 3 stops.

This is effective when a shorter shutter-release time lag is more important than a stable
shutter-release time lag.

Iil Since the difference is in 10-millisecond increments, the time lag may not feel any
shorter.

Enables the electronic dial’s function to be used in the reverse
direction

The electronic dial’s rotational function can be reversed for selecting the AF point and

setting the shutter speed and aperture.

By matching the dial’s rotation direction to the particular operation, the operation can feel

more intuitive.

@ When the Main Dial’s rotational function is reversed, the horizontal AF point selection
direction does not change.

[IF%H Prevents exposure compensation with the Quick Control Dial

© The Quick Control Dial cannot be used to set exposure compensation.

® This prevents exposure compensation from being set accidentally while the AF point is
being selected.
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[ZXFEI] Enables Quick Control Dial switch to turn on/off Main Dial, too

® This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il

® Setting the Quick Control Dial switch to <OFF> disables the Main and Quick Control Dials.

[XTED] Enlargement mode

©® This function is compatible with the EOS-1Ds only.

©® Select which part of an image is enlarged.

® If you take the shot on the camera with this function [ON], you can enlarge an image.

® For more imformation on using this function on the camera, refer to “P.Fn-30 Enlarging the
image” in the EOS-1Ds Instruction Manual.

® © If you wish to enlarge an image, set P.Fn-30 to [ON] during shooting and playback.
The image shot on the camera without setting P.Fn-30 to [ON] cannot be enlarged.
©® The image shot on any camera other than the EOS-1Ds cannot be enlarged.

[XTEA Add original decision data

® This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D Mark
Il and EOS-1Ds.

® The data that shows whether or not the image is the original one can be added to the image.

When selecting the display format of Shooting information (INFO), the [fg ] icon showing the
captured image with Original image verification data is displayed.

For more details, refer to “Shooting Information Display” in the camera’s Instruction Manual.

® To verify whether the image is the original, you will need the EOS dedicated accessory Data
Verification Kit DVK-E2 (optional).

@ The original decision data cannot be added to the JPEG or TIFF image converted from
the RAW image.

Checking Personal Function Settings

You can check the specified Personal Functions and the status of whether or not the settings
are applied to the camera.

Specify the Personal Functions (p.3-8 to p.3-14).

Select the [Combination] tab.

The [Combination] tab sheet appears.

E 1 E 2 3

AF furtaons v furctions
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You can load the Personal
Function settings saved on
your computer (p.3-15).

You can save the specified Personal
Function settings (p.3-15).
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_ _ _ _ Cover/Table of
Saving and Loading Personal Function Settings Contents

You can save the specified Personal Function settings on your computer as a Personal
Function settings file and then load the saved Personal Function settings file and apply the
settings to the camera.

Introduction
Saving the Settings on Your Computer

s N

Click the [Save as] button.

Downloading Images
The [Save As] dialog box appears.

from the Camera

Select the destination folder, enter the file name, and then click L )

the [Save] button. p .
The specified Personal Function settings are saved to the computer as a Personal Setting the Cameras
Function settings file. otherthanthe EOS-1D

Series Cameras

® The Personal Function settings file is not compatible with a camera other than the one
the function was set.

@ To update an existing Personal Function settings file, click the [Save] button. Setting t 0S-1D

Personal Function settings file saved in your computer is compatible with both Series Camieras
Windows and Macintosh.

Loading the Settings Saved on Your Computer _
ol L Remote Shooting

Click the [Open] button.
The [Open] dialog box appears.

Open the folder containing the settings, select the file, and then Troubleshooting
click the [Open] button.
The saved Personal Function settings file is loaded.
Click the [OK] button. Ind
naex

The loaded settings are applied to the
camera, the [Personal functions] dialog
box closes, and the display returns to the [ E
basic settings window. I:":
When a Personal Function is applied to =)

the camera, <> appears on the LCD t e
panel.
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4 Remote Shooting

This chapter explains how to take shots remotely by controlling from your
computer.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-1).

® To perform remote shooting and camera settings for a camera with [Communication]
included as a menu function, you need to set the [Communication] according to the
following table.

[Communication] settings for different cameras

Camera model Menu Setting
® EOS 5D [fT Communication] [PC connect.]
® EOS 30D [T Communication] [Print/PC]
® EOS 20D [¥T Communication] [Normal]
® EOS 10D [Communication] [Normal]

©® EOS DIGITAL REBEL XT/350D DIGITAL

[¥T2 Communication]

[PC connection]

©® EOS DIGITAL REBEL/300D DIGITAL

[¥T2 Communication]

[Normal]

For instructions on settings, refer to “Setting a Camera with [Communication] Settings”
(p.1-2).

©® Click on the item to display its page.

Remote Shooting........cccciieriiniiiii e 4-1
SiNGIE ShOOLING ......eiie it 4-1
B2 2 TS oo ] 1 o SRS 4-2
Interval Timer ShOOtNG........ccuuiiiiii s 4-2

Specifying the Camera Settings ..........ccccviiiiniiinini e 4-3

Specifying Preferences..........cciiiiiininiisiec s 4-3

Remote Shooting
Single Shooting

You can take a shot by remote controlling your camera from a computer.

Click the [Camera settings/Remote shooting] button.

The camera settings window appears.
When switching to the main window, select
the [Window] menu P> [Main Window].

7 EOS Utility - Canon EOS XXX X

Dourloads using camera

‘ﬁ4

Downloads using computer

Press the camera’s button

Starts to download images

Lets you select and download images

®) fal

Camera settings/Remote shooting

Menior folder and import mages

L@ Monitor Folder

The above window shows information
displayable when EOS 30D is connected.
The displayed information varies depending
on the camera model connected.

4-1

' Cover/Table of
Contents

Introduction

Downloading Images
from the Camera

L

Setting the Cameras
otherthanthe EOS-1D
Series Cameras

Setting the EOS-1D
Series Cameras

|
e
|
|
|

ooting

Remo,

Troubleshooting

Index

00O



Specify desired settings.

File  Tool Window

Allows you to specify and —— [~ You can rotate and download the

check the camera settings P shot images regardless of the
(p.4-3). 150 camera position. Each time you click
AWB i the button, the image rotates 90°.

* When using the rotation function,

[E3) = select the [File] menu P
[Preferences], and checkmark the

2..71..0..1..%2 [Rotate image] in the [Remote

Shooting] tab sheet.
OROO

] ONESHOT (\
)
# 1333 |\ | Shoot button

=) a Click to take a shot.

The above window shows information displayable when the EOS 30D is connected.
The displayed information varies depending on the camera model connected.

Click the [@] button.

The shot ime;ijé is transferred to your computer and is displayed in ZoomBrowser EX.

Alternatively, you can press the camera’s shutter button to take a shot.
If you select the [File] menu P> [Exit], EOS Ultility exits, including the camera settings
window.

If the camera is not ready for shooting (the lens is not attached, etc.), you cannot
perform the operation as explained.

When you are using auto focus, you cannot take shots if the camera cannot focus. In
this case, focus manually.

Bulb exposure is not available.

Alternatively, you can press the space bar to take a shot.
The number of available shots changes depending on the available capacity on your
computer’s hard disk. Check the Shots to Go display (p.4-3).
The transfer time to the computer of RAW images shot remotely is approximately 4 to
7 seconds.
» The above time is only an estimate. Transfer times vary widely depending on the
camera model used, the type of computer, and the subject of the photo.
» Transfer times are based on Canon testing standards.
(When using the following: OS: Windows XP, CPU: 2.2 GHz Pentium 4; RAM: 512MB)
* The times for images shot in JPEG will be shorter than those shown above.
You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.4-3).

Timer Shooting

You can automatically take a shot when the specified time elapses.

Select the [Tool] menu P [Timer shooting]

The [Timer shooting setting] dialog box appears.

Enter a delay time and click the [Start] button.

Enter a value between 0 seconds and 99 minutes 59 seconds in 1-second
increments.

The shot is taken when the specified time elapses.

Interval Timer Shooting

You can automatically take shots by setting the interval between shots and the number of shots
to be taken.

' Cover/Table of |
Contents

Introduction

Downloading Images
from the Camera

Setting the Cameras

otherthanthe EOS-1D
Series Cameras

Select the [Tool] menu P [Timer shooting].

a =» The [Timer shooting setting] dialog box appears.

Checkmark the [Interval timer shooting].

4

Enter the shooting interval and the number of shots. Then click
the [Start] button.

) Enter a value between 5 seconds and 99 minutes 59 seconds in 1-second
increments.
© For EOS-1D series cameras, the number of shots is 2 to maximum 1999; for cameras
other than the EOS-1D series cameras, the number of shots is 2 to maximum 999.
Shooting is performed at the specified interval and for the specified number of shots.

@ On some types of computers, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots at
the specified interval. In this case, set a longer interval between shots and take the shots
again.
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Specifying the Camera Settings

You can check and change the settings in the camera from your computer remotely.

Check the camera setting.

Image recording quality ~ Shutter speed

-

[
—M if5  F 56— Aperture
150

— R {5 — SO Speed

&) (EEm+4L)

{=2..71..9..41..92)

Shooting mode

White Balance

Metering mode
The [Preferences] dialog box is

Exposure destination for shot images.

compensation

|— Drive mode

E ] ONESHOT— AF mode
“ & 33-— Shots to Go
|

Bracket shots

Battery status
When you are using a battery,

[ {=mw] ] is displayed. When you
are using the AC Adapter Kit
(optional) or DC Coupler Kit, [ “ ]
is displayed.

Displays the number of
available shots.

Warning display
Displayed when the remote shooting is
impossible due to inappropriate settings.

The above window shows information displayable when the EOS 30D is connected.

The displayed information varies depending on the camera model connected.

Set the functions which you cannot set remotely (drive mode, AF mode etc.) directly

in the camera.

In the [Remote Shooting] tab sheet in the [Preferences], you can save shot images to
both your computer and the memory card by setting [Save also to camera’s memory

card].

Click the icon to be set.

E amaL

Save destination of shot images

displayed and you can set the save

The icon displayed here shows exposure
compensation as an example. ‘

Use the buttons to change a value.

Allows you to decrease
the value by 1 step.

Specifies the
minimum value.

Specifies the
maximum value.

The changed settings are applied to the camera.

® Before you specify the settings, be sure to check that the camera is ready for shooting. If

the camera is not ready for shooting (the lens is not attached, etc.), you cannot make
some of the settings.

Allows you toincrease

@ @ G) @ the value by 1 step.
| 1

Settable functions and settings displays by camera model
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©: Allows you to display camera settings and perform camera settings
O: Allows you to display camera settings; camera settings not possible
b - Display with EOS-1Ds not possible
"2 : Setting with EOS 10D not possible

Specifying Preferences

You can perform various EOS Utility settings.

« Select the [File] menu P [Preferences]

The [Preferences] dialog box appears.

Specify desired settings and click the [OK] button.
The settings are applied to the EOS Utility.
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Troubleshooting

This chapter provides troubleshooting and explains how to uninstall the
software.

Troubleshooting

If you could not complete the installation correctly, or communication between the camera and
computer fails, or you connected the camera and computer before installing the software,
consult the items described below.

® For instructions on installing, refer to the “Software Guide” supplied with the camera.

Installation failed.

@ Are you using Windows XP under a setting other than [Computer
administrator] privileges or using Windows 2000 under a setting other than
[Administrator] privileges?

- You cannot install software if a user setting other than [Computer administrator]
privileges or [Administrator] privileges is selected. Select the [Computer administrator]
privileges user setting in Windows XP or the [Administrator] privileges user setting in
Windows 2000. For detailed information on selecting the user setting, refer to your
computer’s instruction manual.

@ Is the cable firmly plugged into its socket?
- To complete the installation, ensure that the plugs on the dedicated cable are securely
plugged into the ports on the camera and computer when you connect the camera to
your computer.

® Are the camera and computer set up correctly for communication?

- Is the camera’s power switch set to <ON>?

- Even when the camera’s power switch is set to <ON>, operation of the Auto power off
function will automatically switch the camera off. To prevent this, set the Auto power off
function to [Off]. For more details, refer to the camera’s Instruction Manual supplied with
the camera.

® Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in
Windows 2000) dialog box appear during installation?
- Click the [Cancel] button, disconnect the dedicated cable, and then repeat the
installation procedure from the beginning.

® Doesn’t the installer panel appear?
- Use the following procedure to display the installer panel.
Click the [Start] button » [My Computer]. (In Windows 2000, double-click
[My Computer] on the desktop.) P click on the CD-ROM drive containing
the CD with the right button on the mouse P select [Open] from the menu
that appears P double-click the icon on the right.

SETUR

Click on the item to display its page.

TroubleShOOting ......ccceiiiiiiiir i —————— 5-1
Uninstalling the SOftWare ... 5-3

UNinstalling the DIIVET ........oiiiiiiii e 5-3
Folder Structure and File Names ... 5-4
g e 1= N 5-4

| have installed the software but the camera and
computer cannot communicate.

@ Is the driver installed?

- The driver is required for communication between the camera and computer. When you
want to communicate between the camera and computer, be sure to install the driver
shown below appropriate to your windows.

» Windows XP: WIA Driver
» Windows 2000: TWAIN Driver

® Have you installed the WIA Driver or TWAIN Driver?

- Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed
unless the camera is connected to the computer. Insert the Solution Disk into the CD-ROM
drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your
computer.

® Does your computer comply with these requirements?
B Cameras other than EOS-1D series cameras
- Computer with Windows XP or Windows 2000 preinstalled and equipped with a USB
port as a standard feature.
* Operation is not guaranteed when a connection is used on computer systems other
than those listed above.
B EOS-1D series cameras
- Computer with Windows XP or Windows 2000 preinstalled and equipped with an
OHCI-compliant IEEE1394 port.
* Operation is not guaranteed when a connection is used on computer systems other
than those listed above.

® Are the camera and computer connected correctly?
- Connect the camera to your computer correctly using the dedicated cable (p.1-3, p.1-4).

® Have you made the correct [Communication] settings for cameras that
require [Communication] settings?

- Set the camera’s [Communication] to [PC connect.] or [PC connection] for the EOS 5D
and EOS DIGITAL REBEL XT/350D DIGITAL, to [Print/PC] for the EOS 30D, and to
[Normal] for the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL (p.1-2).
* With the EOS 10D, you must also change the firmware to version 2.0.0 or later. For

details on changing, refer to the Canon’s web site.

5-1
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@ Is there sufficient charge left in the camera battery?

- Your computer does not supply power to the camera. Connect the AC Adapter Kit
(optional) for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL REBEL XT/
350D DIGITAL and EOS DIGITAL REBEL/300D DIGITAL, the DC Coupler supplied with
the camera for the EOS D60 and EOS D30, and the DC Coupler Kit supplied with the
camera for the EOS-1D series cameras. Alternatively, insert a fully charged battery and
connect your computer and camera.

® Do you have more than one camera connected to your computer?
If you connect more than one camera to the same computer, the driver and camera may not
operate normally.
- Exit the software and disconnect all the dedicated cables. Then connect only one
camera to the same computer again.

@ Is the driver operating normally?
Connect the camera to your computer
with the dedicated cable and set the
camera’s power switch to <ON> and
open [Device Manager].

Click the plus symbol [+] to the left of

[Imaging devices] and check that the

connected camera is displayed.

- If the connected camera is not
displayed, the driver is not operating
normally.

Briefly disconnect and then reconnect the dedicated cable, ensuring that the connection
is secure. If the connected camera still does not appear, use the following procedure to
re-install the driver.

Disconnect the dedicated cable and delete the driver (p.5-3).

Re-install the driver.

- When the [X], ['] or [?] symbol is displayed beside the connected camera, part of the

driver is missing or corrupted. Use the following procedure to re-install the driver.
Delete the camera displayed in [Imaging devices].
Disconnect the dedicated cable and delete the driver (p.5-3).
Re-install the driver.

7, Device Manaper

Bl Acton  Wew  Helb

@ Is the driver installed correctly?

- Connect the camera to your computer with the dedicated cable and set the camera’s
power switch to <ON> and open [Device Manager]. Click the plus symbol [+] to the left of
[Other devices] or [Unknown devices] and check whether the connected camera or
[Canon Digital Camera] is displayed.

T, Device Manager

Bl Acton  Wew  Heb

7, Device Manaper

+1 2 Flopy dek controbers
SR —

=1 3 IDE ATATATAS] coterobins + 3 IDE ATAATAS controlers

+1 oG IECE 1794 Dus hegt cortrobirs +) oG [EEE 1794 Dus host controbers
* i Kevbosrds + o Kerboards

=Ty Mice and other pownting devices =Ty Mice and other pownting devices
# W Morkors = W Monkors

=2
+ I Floppy disk drives

- If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or
[Unknown devices], the driver was not installed correctly. Use the following procedure to
re-install the driver.

Delete the camera or [Canon Digital Camera] displayed in [Other devices] or
[Unknown devices].

Disconnect the dedicated cable and delete the driver (p.5-3).

Re-install the driver.

| connected the camera to the computer before installing
the software

® Did you set the camera’s power switch to <ON>?
- If you did not set the camera’s power switch to <ON>, proceed as follows:
Disconnect the dedicated cable from the camera and computer.
Install the Solution Disk software on your computer using the correct installation

procedure and then connect the camera to your computer to complete the installation.

- If you set the camera’s power switch to <ON>, proceed as follows:
If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel]
buttons to cancel all the dialog boxes.
Set the camera’s power switch to <OFF>.
Disconnect the dedicated cable from the camera and computer.
4 Install the Solution Disk software on your computer using the correct installation

procedure and then connect the camera to your computer to complete the installation.

To Display the Device Manager

® Windows XP
- Click the [Start] button B> select [Control Panel] B> [Performance and Maintenance]
» [See basic information about your computer]. Then select the [Hardware] tab
and click the [Device Manager] button.

® Windows 2000
- Click the [Start] button P> select [Settings] P> [Control Panel]. Then double-click the
[System] icon to open and select the [Hardware] tab and click the
[Device Manager] button.
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Uninstalling the Software

® Log in under [Computer administrator]/[Administrator] privileges when uninstalling the
software.

© Before starting the software uninstallation, exit all programs you are using and disconnect
the dedicated cable from your computer.

® To prevent computer malfunctions, always restart your computer after you have uninstalled
the software. Re-installing the software without first restarting your computer is likely to
result in computer malfunctions.

Click the [Start] button P> select [All Programs] ([Programs] in
Windows 2000) » [Canon Utilities] » [EOS Utility] » [EOS Utility
Uninstall].

Proceed with the uninstallation as directed by the on-screen
messages.

=» Software is uninstalled.

Uninstalling the Driver

This section explains how to uninstall the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS 5D, EOS
30D, EOS 20D and EOS DIGITAL REBEL XT/350D DIGITAL driver. Refer to the software
Instruction Manual supplied with the camera about deleting drivers in cameras other than those
mentioned above.
Log in under [Computer administrator]/[Administrator] privileges when uninstalling the
driver.
Before starting the driver uninstallation, exit all programs you are using and disconnect the
dedicated cable from your computer.

Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].

Your camera model is displayed in EOS XXX.

For Windows XP, click the [Start] button P> select [All Programs] B> [Canon Utilities] »
[EOS XXX WIA Driver] B [WIA Driver Uninstall].

For Windows 2000, click the [Start] button P> select [Programs] B> [Canon Utilities]
[EOS XXX TWAIN Driver] » [TWAIN Driver Uninstall].

Proceed with the uninstallation as directed by the on-screen
messages.

=» The driver is uninstalled.
Restart the computer.

= > When the dialog box on the right appears,
select the [Yes, | want to restart my
computer now.] and click [Finish] button.
=» When the computer is restarted,
uninstalling of the driver is completed.

InstaltShield Wizard

InstaltShield Wized Complete

Dirsven unskabaion fresheed Restan somputss,

B =) B
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Folder Structure and File Names

Images shot with the camera are saved in the memory card’s [DCIM] folder, with the following
folder structure and file names.

C—

DCIM xxxCANON

Cameras other than EOS-1D series cameras

or File name Image type/Camera used
xxXEOS5D IMG_YYYY.JPG JPEG image
EOS 5D, EOS 30D, EOS 20D, EOS DIGITAL
IMG_YYYY.CR2 | W | REBEL XT/350D DIGITAL
image | EOS 10D, EOS DIGITAL REBEL/300D DIGITAL,
IMG_YYYY.CRW EOS D60, EOS D30
CRW_YYYY.THM Image for displaying the camera’s index
The “YYYY” in the file names represents a number between 0001 and 9999.
— EOS-1D series cameras
xxxEOS1D File name Image type/Camera used
*YYYY.JPG JPEG image
**YYYY.CR2 | raw |EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D Mark Il
*YYYY.TIF image | EOS-1Ds, EOS-1D
*YYYY.WAV Audio file

The camera specific character string set at the time of factory shipment
appears in “****” of the file name.

The camera specific character string set at the time of factory shipment or
set in the camera appears in “****” of images shot with the EOS-1D Mark Il N.
The “YYYY” in the file names represents a number between 0001 and 9999.

The folder that holds the image control files in the [DCIM] folder.

—(

CANONMSC

The “xxx” in the folder names represent a number between 100 to 999.

The folder structure for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark Il
CF card and SD card is the same.

When you perform DPOF settings on the camera, a [MISC] folder is created. The files
that manage the DPOF settings are saved in the [MISC] folder.

@ When Adobe RGB is specified, the file names of images shot with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS 5D, EOS 30D, EOS 20D and EOS DIGITAL
REBEL XT/350D DIGITAL have an underbar “_” as the first character.
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